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What is the Reference Services Web Portal? 

 

he Reference Services Web Portal is a way for all of the Marshfield Labs’ Reference clients 

to access and maintain their client information remotely and securely through a web 

browser. The Reference Services Web Portal allows clients to order tests; view test results; 

order supplies; maintain user security; request and monitor courier service; view trending reports, 

volume reports, and billing information; as well as pay any outstanding balances with a credit card. 

  T 
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 Getting Started 

Opening the Reference Services Web Portal 

1. Open your Internet Browser. 
 

2. Type in the following address:  https://www.marshfieldclinic.org/reference/ 
 

First-Time Log In 

1. Click Client Log In. 
 

2. In the User Name text box, type in your user name. 
 
3. Press the Tab key.  

 
OR 
 
Click on the Password text box. 
 

4. Type in your password. 
 
5. After your user name and password have been entered, click Log In. 
 
6. A screen will prompt you to create a new password. 
 
7. Click on the New Password text box and type in a new password. 
 

NOTE: The new password must be at least 6 characters long, contain at least 2 numbers, 

contain no spaces, and cannot match your current user name or a recent password. 

 
8. Press the Tab key. 

 
OR 
 
Click on the Confirm New Password text box. 

 
9. Retype your new password. 
 
10. Click Submit. 

Log In 

To view any client-specific information, Client Log In is required.  
 
1. In the User Name text box, type in your user name. 

 
2. Press the Tab key.  

 
OR 
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Click on the Password text box. 
 

3. Type in your password. 
 

NOTE:  The Password is sensitive to capital and lowercase letters. For example, if your 

password is “ Password00” then PASSWORD00, password00, or pASSWORD00 will 

not be accepted.If you have forgotten your User Name or Password, call 1-866-522-2611. 

 
4. After your user name and password have been entered, click Log In. 

Log Out 

1. Click Log Out. 
 

 

Patient Demographics  

Patient Admin 

The Patient Admin menu allows users to quickly add patients or update patient 
demographics without ordering tests. 
 

 
1. From the Patient Demographics menu, select Patient Admin. 

 
2. In the Patient ID text box, type in the new patient ID. 
 
3. Click Search. 

 
4. Under the Patient Information tab, click on or tab to each field to fill in the patient's 

information. 
 

NOTE: The ‘State’ field will default to the state in which the account resides. 

 
5. If the patient has a Guarantor, click on the Guarantor Information link. 

a. The guarantor information entered will be order specific. So, once the information 
is entered and the order is submitted, the next order placed on that same patient 
will need to have the guarantor information reentered. The guarantor information 
will display on the review tab along with the confirmation page for that specific 
order as well. NOTE: If the first order for a specific patient is placed with 
guarantor information and then a second order is placed with different guarantor 
information on that same patient, both orders will reflect the latest guarantor 
information that was added to the system.  
 

6. Click on the Primary Insurance Tab. Select the patient’s Primary Insurance carrier from 
the drop-down list. 

 

NOTE: If the patient’s insurance carrier is not included in the list select, Other and fill in all 

fields. If the patient does not have a Primary Insurance carrier, select None. 

NOTE: If a patient has both Medicare and Medicaid coverage, under the primary insurance 

tab, select Medicare and in the Group # field, place the Medicaid Number. 
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7. Click on (or Tab to) each text box and fill in the primary insurance information. 
 

8. If applicable, select the patient’s Secondary Insurance carrier from the drop-down list. 
 

NOTE: If the patient’s insurance carrier is not included in the list select, Other and fill in all 

fields. If the patient does not have a Secondary Insurance carrier, select None. 

 
9. Click Submit on the Patient Information tab to continue creating the patient. 

  
 

Update a Patient’s Demographics 

1. From the Patient Demographic menu, select Patient Admin. 
 

 
2. In the Patient ID text box, type in the patient ID. 
 

OR 
 
If the patient ID is unknown, follow steps 2.1-2.3. 
 

 
Search Instructions: 

 
2.1 Input known information into the text boxes. 
 

NOTE: When performing a search by demographic information, either a partial Last Name 

or an entire Telephone Number must be provided in order to begin the search. 

 
2.2 Click Search to perform the patient search. 

 
2.3 The search will display a list of patients that meet the given criteria. Click on the 

hyperlinked Patient ID to select the appropriate patient from the list and continue 
with the order entry process or go to the Patient Admin menu to create a new 
patient. 

 
 

3. Edit the patient information as necessary by clicking in the text boxes and retyping 
information and/or using the drop-down lists. 

 
4. Click Submit to update the patient’s demographics. 

 

Patient Merge 

The Patient Merge menu allows users to combine two patient records that actually belong 
to the same person. All historical and pending tests for the incorrect patient will now 
appear under the correct patient. 
 

1. From the Patient Demographics menu, select Patient Merge. 
 

2. Type in the incorrect patient ID. 
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3. Type in the correct patient ID. 
 

4. Click Next. 
 

5. Verify both the Incorrect Patient and Correct Patient information. 
 

6. Click Submit to merge the two patients. 
 
OR 
 
Click Back to go back to Step 1 of Patient Merge. 

 

NOTE: The merge process is permanent and cannot be undone after Submit is clicked. 

 
7. A message will be sent once the merge process has been completed. 

 
 

Request Service 

Order Clinical Tests 

1. From the Request Service menu, select Order Tests 
 
OR 
 
Select Order Tests from the top navigational tool bar. 

 
2. Type the Patient ID into the text box given and click Search 
 

OR 
 
If the Patient ID is unknown, follow steps 2.1-2.3 

 
Search Instructions: 

 
2.1 Input known information into the text boxes. 
 

NOTE:  When performing a search by demographic information, either a partial Last Name 

or entire Telephone Number must be provided in order to begin the search. 

 
2.2 Click Search to perform the patient search. 

 
a. The search will display a list of patients that meet the given criteria. Click on the 

hyperlinked Patient ID to select the appropriate patient from the list and continue 
with the order entry process or click on New to create a new patient. 

 
 

3. Enter or verify the correct information. 
 

4. Click on the Primary and/or Secondary Insurance Tabs. 
 

5. Enter or verify the correct information. 
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NOTE: For information on entering patient and insurance information, see steps 4-8 of the 

Error! Reference source not found. section on p. Error! Bookmark not defined.. 

 
6. Click on the Order Details tab. Select a provider from the drop-down list. 

 

NOTE:  If there is only one provider in the Requesting Provider list, that name will be selected 

automatically in the drop-down list. 

 
7. If necessary, modify the Collection Date and Collection Time. 

NOTE:  The Collection Time is displayed in military time. 

8. Select a Priority from the drop-down list. 
 
9. If your Client is NOT configured to receive all results automatically via fax, select the Fax 

and/or Call option and input the appropriate number to receive the results for this 
particular order. 

NOTE:  Selecting the Call or Fax option only makes changes for this order. It does not affect 

future orders. Also, if you are already set up to receive faxed or called results, the Fax and Call 
boxes do not need to be checked. 

 
10. At least one Diagnosis Code must be assigned per test if the patient has insurance. 

 
11. If the diagnosis codes are unknown, click on the hyperlinked Advanced Search to 

search for a code(s) on a particular diagnosis. Enter a description and click Search. 
Check the box in front of the appropriate code from the search list. 

 
OR 
 
Click Cancel to close the search box. 
 

NOTE: Clicking on the ICD-9 Ref Sheet text will bring up a 31 page reference sheet in PDF 

format. 

 
12. Check the ABN box if the Advance Beneficiary Notice form has been signed. 
 
13. Click on the Test Selection tab to select the appropriate tests to order for the patient. 

 
14. Select the My List tab to order a test from the top 20 most commonly ordered tests.  

 

NOTE: The tests listed in the My List tab can be defined by the user through Test Code 

Adminsation found under the Settings menu. 

OR 
 
Select the Alpha tabs to find a test by description. 
 
OR 
 
Select the Misc. tab to order a miscellaneous test if the test code is not found in the lists.  
 
OR 
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Click in the Keywords search box to search for a test by inputting a test code, synonym 
or a description. Click Search. Click on the appropriate test. 
 

NOTE: Some tests require a field to be completed when selected (e.g., the Urinalysis Complete 

test). The appropriate information must be typed into this field before the program will proceed 

with the order. 

 

NOTE: To view test details, click on the book icon next to the Test Code. 

 
15. Once all the tests have been selected and are appearing in the Ordered Tests box, the 

diagnosis codes for the tests can be edited or the test can be removed. 

NOTE: To view test details, click on the book icon next to the Test Code. 

16. To Edit Diagnosis Codes, click Edit after the test name. The Test Selection Data box 
will appear. Edit any of the information. Click Update. 
 
OR 
 
To Add a Diagnosis Code, click Edit after the test name. In an empty code box and add 
the code number and click Update. 
 
OR 
 
To Remove a Test, click on the Remove link after the test name in the Ordered Tests 
box. 
 

17. Type in the Label ID (6 digits followed by the letter H) 
  

OR 
 
  Type in the Order ID (if left blank, the Order ID will auto-fill when the order is placed). 

 
18. Type any necessary comments into the Additional Comments text box. 

 
19. Check the Confirmation Page check box to display a copy of the confirmation page after 

submitting the order 
 

OR 
 

20. Uncheck the Confirmation Page check box to NOT display a copy of the confirmation 
page after submitting the order. 

 
21. Click the Review tab to review entire order, prior to placing the order. 

 
22. Click Order to submit the order. 
 
23. An Order Confirmation page will display giving information about the order just 

submitted, if the check box was checked.  
 

24. Print this page for personal records by clicking on File and selecting Print. 
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Order Cytology Tests 

1. From the Request Service menu, select Order Tests 
 
OR 
 
Select Order Tests from the top navigational tool bar. 

 
2. Type the Patient ID into the text box given and click Search 
 

OR 
 
If the Patient ID is unknown, follow steps 2.1-2.3 

 
Search Instructions: 

 
2.1 Input known information into the text boxes. 
 

NOTE:  When performing a search by demographic information, either a partial Last Name 

or entire Telephone Number must be provided in order to begin the search. 

 
3.3 Click Search to perform the patient search. 

 
a. The search will display a list of patients that meet the given criteria. Click on the 

hyperlinked Patient ID to select the appropriate patient from the list and continue 
with the order entry process or click on New to create a new patient. 

 
 

3. Enter or verify the correct information. 
 

4. Click on the Primary and/or Secondary Insurance Tabs. 
 

5. Enter or verify the correct information. 
 

NOTE: For information on entering patient and insurance information, see steps 4-8 of the 

Error! Reference source not found. section on p. Error! Bookmark not defined.. 

 
6. Click on the Order Details tab. Select a provider from the drop-down list. 

 

NOTE:  If there is only one provider in the Requesting Provider list, that name will be selected 

automatically in the drop-down list. 

 
7. If necessary, modify the Collection Date and Collection Time. 

NOTE:  The Collection Time is displayed in military time. 

8. Select a Priority from the drop-down list. 
 
9. If your Client is NOT configured to receive all results automatically via fax, select the Fax 

and/or Call option and input the appropriate number to receive the results for this 
particular order. 

NOTE:  Selecting the Call or Fax option only makes changes for this order. It does not affect 

future orders. Also, if you are already set up to receive faxed or called results, the Fax and Call 
boxes do not need to be checked. 



Reference Services Web Portal 

Copyright © 1995-2015Marshfield Clinic. All rights reserved. 10 

 
10. At least one Diagnosis Code must be assigned per test if the patient has insurance. 

 
11. If the diagnosis codes are unknown, click on the hyperlinked Advanced Search to 

search for a code(s) on a particular diagnosis. Enter a description and click Search. 
Check the box in front of the appropriate code from the search list. 

 
OR 
 
Click Cancel to close the search box. 
 

NOTE: Clicking on the ICD-9 Ref Sheet text will bring up a 31 page reference sheet in PDF 

format. 

 
12. Check the ABN box if the Advance Beneficiary Notice form has been signed. 
 
13. Click on the Test Selection tab to select the appropriate tests to order for the patient. 

 
14. Click the cytology test from the Cytology/Histology tab. 

 
15. Click on any of the Cytology – Gyn or Cytology – NonGyn tests or order. 

 

NOTE: The Cytology tests require fields to be completed when selected. The appropriate 

information must be typed into this field before the program will proceed with the order. 

 
16. Click Edit after the test name. The Test Selection Data box will appear. Edit any of the 

information. Click Update. 
 
OR 
 
To Remove a Test, click on the Remove link after the test name in the Ordered Tests 
box. 
 

17. Type in the Label ID (6 digits followed by the letter H) 
  

OR 
 
  Type in the Order ID (if left blank, the Order ID will auto-fill when the order is placed). 

 
18. Type any necessary comments into the Additional Comments text box. 

 
19. Check the Confirmation Page check box to display a copy of the confirmation page after 

submitting the order 
 

OR 
 

20. Uncheck the Confirmation Page check box to NOT display a copy of the confirmation 
page after submitting the order. 

 
21. Click the Review tab to review entire order, prior to placing the order. 

 
22. Click Order to submit the order. 
 
23. An Order Confirmation page will display giving information about the order just 

submitted, if the check box was checked.  
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24. Print this page for personal records by clicking on File and selecting Print. 
 

Order Histology Tests 

1. From the Request Service menu, select Order Tests 
 
OR 
 
Select Order Tests from the top navigational tool bar. 

 
2. Type the Patient ID into the text box given and click Search 
 

OR 
 
If the Patient ID is unknown, follow steps 2.1-2.3 

 
Search Instructions: 

 
2.1 Input known information into the text boxes. 
 

NOTE:  When performing a search by demographic information, either a partial Last Name 

or entire Telephone Number must be provided in order to begin the search. 

 
4.4 Click Search to perform the patient search. 

 
b. The search will display a list of patients that meet the given criteria. Click on the 

hyperlinked Patient ID to select the appropriate patient from the list and continue 
with the order entry process or click on New to create a new patient. 

 
 

3. Enter or verify the correct information. 
 

4. Click on the Primary and/or Secondary Insurance Tabs. 
 

5. Enter or verify the correct information. 
 

NOTE: For information on entering patient and insurance information, see steps 4-8 of the 

Error! Reference source not found. section on p. Error! Bookmark not defined.. 

 
6. Click on the Order Details tab. Select a provider from the drop-down list. 

 

NOTE:  If there is only one provider in the Requesting Provider list, that name will be selected 

automatically in the drop-down list. 

 
7. If necessary, modify the Collection Date and Collection Time. 

NOTE:  The Collection Time is displayed in military time. 

8. Select a Priority from the drop-down list. 
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9. If your Client is NOT configured to receive all results automatically via fax, select the Fax 
and/or Call option and input the appropriate number to receive the results for this 
particular order. 

NOTE:  Selecting the Call or Fax option only makes changes for this order. It does not affect 

future orders. Also, if you are already set up to receive faxed or called results, the Fax and Call 
boxes do not need to be checked. 

 
10. At least one Diagnosis Code must be assigned per test if the patient has insurance. 

 
11. If the diagnosis codes are unknown, click on the hyperlinked Advanced Search to 

search for a code(s) on a particular diagnosis. Enter a description and click Search. 
Check the box in front of the appropriate code from the search list. 

 
OR 
 
Click Cancel to close the search box. 
 

NOTE: Clicking on the ICD-9 Ref Sheet text will bring up a 31 page reference sheet in PDF 

format. 

 
12. Check the ABN box if the Advance Beneficiary Notice form has been signed. 
 
13. Click on the Test Selection tab to select the appropriate tests to order for the patient. 

 
14. Click the Histology test under the Histology section of the Cytology/Histology tab. 

 

NOTE: The Cytology tests require fields to be completed when selected. The appropriate 

information must be typed into this field before the program will proceed with the order. 

 
15. Click Edit after the test name. The Test Selection Data box will appear. Edit any of the 

information. Click Update. 
 
OR 
 
To Remove a Test, click on the Remove link after the test name in the Ordered Tests 
box. 
 

16. Type in the Label ID (6 digits followed by the letter H) 
  

OR 
 
  Type in the Order ID (if left blank, the Order ID will auto-fill when the order is placed). 

 
17. Type any necessary comments into the Additional Comments text box. 

 
18. Check the Confirmation Page check box to display a copy of the confirmation page after 

submitting the order 
 

OR 
 

19. Uncheck the Confirmation Page check box to NOT display a copy of the confirmation 
page after submitting the order. 

 
20. Click the Review tab to review entire order, prior to placing the order. 
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21. Click Order to submit the order. 
 
22. An Order Confirmation page will display giving information about the order just 

submitted, if the check box was checked.  
 

23. Print this page for personal records by clicking on File and selecting Print. 
 

Change Existing Lab Order 

Clicking on the Change Existing Lab Order link retrieves all pending orders (e.g. orders 
with a status of Ordered, In Transit) by patient ID or date range. 

NOTE: Change Order does not modify patient information, collection data, or original order comments. 

 

Search by Patient  
 

1. From the Request Service menu, select Change Existing Lab Order. 
 

2. Type in the Patient ID and click Submit. 
 
OR 
 
If the Patient ID is unknown, follow steps 1.1-1.3. 

 
 

Search Instructions 
 

1.1 Input known information into the text boxes. 
 

NOTE: When performing a search by demographic information, either a partial Last Name 

or an entire Telephone Number must be provided in order to begin the search. 

 
1.2 Click Search to perform the patient search. 

 
1.3 The search will display a list of patients that meet the given criteria. Click on the 

hyperlinked Patient ID to select the appropriate patient from the list and continue 
with the change order process or click on New to create a new patient. 

 
 

3. Click on the Label icon to reprint labels. 
 

4. Click on the Pencil icon next to the accession (order) to change. 
 

NOTE: Since only orders with a status of Ordered, In Transit can be modified in change 

order, the Pencil icon will not appear next to orders with any other status. 

 
5. Order Details Tab: the Diagnosis Codes and ABN signed are the only two features that 

can be modified under this tab. 
 

6. Test Selection Tab: Add, Remove or Modify tests as appropriate. 
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7. Click Edit after the test name. The Test Selection Data box will appear. Edit any of the 
information. Click Update. 
 
OR 
 
To Remove a Test, click on the Remove link after the test name in the Ordered Tests 
box. 
 

8. Additional Comments can be added. 
 

9. A comment in the Modification Reason text box is required to proceed with the order 
change. 

 
10. Click Update to submit the order 

 
OR 
 
Click Cancel Order to cancel entire order. 

 
11. A confirmation page will display giving the accession number and other pertinent 

information regarding the changes just submitted. 
 

12. Print this page for personal records by clicking on the File menu and selecting Print. 
 
 

Search by Collection Date 
 

1. From the Request Service menu, select Change Existing Lab Order. 
 

2. Select a Start Date and an End Date. 
 

3. Click Search. 
 

4. Click on the Pencil icon next to the accession (order) to change. 
 

NOTE: Since only orders with a status of Ordered, In Transit can be modified in change 

order, the Pencil icon will not appear next to orders with any other status. 

 
5. Order Details Tab: the Diagnosis Codes and ABN signed are the only two features that 

can be modified under this tab. 
 

6. Test Selection Tab: Add, Remove or Modify tests as appropriate. 
 
7. Click Edit after the test name. The Test Selection Data box will appear. Edit any of the 

information. Click Update. 
 
OR 
 
To Remove a Test, click on the Remove link after the test name in the Ordered Tests 
box. 
 

8. Additional Comments can be added. 
 

9. A comment in the Modification Reason text box is required to proceed with the order 
change. 
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10. Click Update to submit the order 
 
OR 
 
Click Cancel Order to cancel entire order. 

 
11. A confirmation page will display giving the accession number and other pertinent 

information regarding the changes just submitted. 
 

12. Print this page for personal records by clicking on the File menu and selecting Print. 
 

Request Courier Pickup 

Request Courier Pickup allows the user to request a courier stop. This feature only applies 
if you use Marshfield Clinic’s courier services. 
 
 

1. From the Request Service menu, select Request Courier Pickup. 
 

2. Click on the Stop Date drop-down list to select a date for the courier to stop. 
 

NOTE:  If the client account has multiple courier routes each day (i.e. a morning route and an 

afternoon route), selecting a stop date will request a stop for the first available route. 

 
3. Click Next. 

 
4. A page will appear giving the earliest date the courier can stop. 

 
NOTE:  If the Call-By Time has passed, the user will receive a notification in red, bold print. 

 
5. Click on the drop-down list to see all of the options for the date listed. 
 

 
6. If the Pickup Day listed is acceptable, enter any necessary Comments then click 

Confirm. 
 
 OR 
 

If the Stop Date listed is unacceptable, click on Cancel and contact Lab Customer 
Service (1-866-522-2611) for options on earlier courier stops. 
 

7. A message will appear signifying that the stop request was successful. 
 

Order Lab Supplies 

Use the Order Lab Supplies page to request supplies to be sent or routed to you. All 
supplies ordered here will be directly billed to your client account. 
 

1. From the Request Service menu, select Order Lab Supplies. 
 

2. Locate the appropriate supply item from the supplies tabs. 
 

3. Click on the appropriate supply item in the list. 
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NOTE:  Click on the book icon to name to view the minimum quantity to order and a more 

detailed description and picture of each item. 

 
4. Type a number into the Quantity field to order a specified quantity of that supply item. 
 
5. Click Add. 

 
6. To Edit a Supply, click Edit after the supply name. The Supply Data box will appear. Edit 

any of the quantities. Click Update. 
 
OR 
 
To Remove a Supply, click on the Remove link after the supply name in the Ordered 
Tests box. 
 

7. Additional comments can also be made in the Additional Comments text box. 
 

8. If the order is placed, an Order Complete message will appear above the order. Click 
the Print icon to print the order.  

 
 
 
 

Packing List 

Print Pending Orders 

The Print Pending Orders is a list of items that have not yet been printed on a Packing List. 
 

1. From the Packing List menu, select Print Packing Orders. 
 

NOTE: Make sure all modifications to orders are made prior to printing. 

 
2. Click Print, located on the right side of the top navigational toolbar to create the printable 

version of the packing list. 
 

3. Another window will appear displaying the printable version of the packing list. From the 
File menu, select Print. 
 

4. The packing list will subdivide into 3 separate packing lists (if applicable): Clinical, 
Cytology, and Histology. Each packing list needs to be included with its respective 
samples. 
 

Print Merged List 

The Print Merged List is a list of order that have been previously printed and any non-printed 
orders that are outstanding. 
 

1. From the Packing List menu, select Print Merged List. 
 
2. Click Reprint to create one merged Packing list containing all orders that have been 
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entered since the last shipment. This packing list will contain orders from previously 
printed lists and any non-printed orders that are outstanding. 

 
3. Another window will appear displaying the printable version of the packing list. From the 

File menu, select Print. 
 

4. The packing list will subdivide into 3 separate packing lists (if applicable): Clinical, 
Cytology, and Histology. Each packing list needs to be included with its respective 
samples. 

Recent Print History 

The Recent Print History list all the Packing Lists that have been printed within the past 7 days. 
 

1. From the Packing List menu, select Recent Print History. 
 

Click on a link within the Printed Packing List box to view the document in a PDF format. 
 

2. Another window will appear displaying the printable version of the packing list. From the 
File menu, select Print. 
 

3. The packing list will subdivide into 3 separate packing lists (if applicable): Clinical, 
Cytology, and Histology. Each packing list needs to be included with its respective 
samples. 

Offline Packing List 

The Offline Packing List is a feature designed to proactively assist you during times of Internet or 
website downs when your online Packing List is unavailable to you. 
 
It’s highly recommended to print and store a blank copy of each Offline Packing List for 
emergency purposes. When your online Packing List is unavailable, simply fill in the Offline 
Packing List and submit it with your samples to your courier. 
 
 

Test Results 

View Results 

The user can view the results of tests by Patient ID, or Collection Date of the tests. 
 

Search by Unviewed Results 
 

1. Click on Results from the top navigational tool bar. 
 

2. Click on an Accession/Case ID number. 
 

NOTE:  Red font indicates that there is an abnormal results. 

 

Search by Patient 
 

1. From the Test Results menu, select View Results. 
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2. Type in the Patient ID and click Submit. 

 
OR 
 
If the Patient ID is unknown, follow steps 1.1-1.3. 

 
 

Search Instructions 
 

1.4 Input known information into the text boxes. 
 

NOTE: When performing a search by demographic information, either a partial Last Name 

or an entire Telephone Number must be provided in order to begin the search. 

 
1.5 Click Search to perform the patient search. 

 
1.6 The search will display a list of patients that meet the given criteria. Click on the 

hyperlinked Patient ID to select the appropriate patient from the list and continue 
with the change order process or click on New to create a new patient. 

 
 

3. Click on a hyperlinked test accession to view the Results. 
 

NOTE: Result details can only be viewed if the test status is Final Result Available. 

 
4. The results page will appear with the options to open attachments (if applicable), print or 

fax results, and choose to add-on test(s). 
 
To View Attachment: 
 

 Click on the Attachment button. 
 

 Select an image to view. 
 

To Fax Results: 
 

 Check the Fax check box on the left navigation tool bar. 
 

 Fill in the appropriate information. 
 

 Click Submit. 
 

To Print Results: 
 

 Click Print in the top navigational tool bar. 
 

 Another window will appear. 
 

 Select File and click Print. 
 
To Add On Test: 
 

 Click on Add On in the top navigational tool bar. 
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 The Add On Test window will appear. 
 

 Order Details Tab: the Diagnosis Codes and ABN signed are the only two 
features that can be modified under this tab. 
 

 Test Selection Tab: Add test(s). 
 

 To Edit a Test, click Edit after the test name. The Test Selection Data box 
will appear. Edit any of the information. Click Update. 

 
 OR 

 
 To Remove a Test, click on the Remove link after the test name in the 

Ordered Tests box. 
 

 Additional Comments can be added. 
 

 Click Add-On to submit the order 
 

Search by Identifier 
 

1. From the Test Results menu, select View Results. 
 

2. Type in the Accession Number, Client Order Number or Case ID. 
 

3. Click Submit. 
 

4. Click on a hyperlinked test accession to view the Results. 
 

NOTE: Result details can only be viewed if the test status is Final Result Available. 

 
5. The results page will appear with the options to open attachments (if applicable), print or 

fax results, and choose to add-on test(s). 
 
To View Attachment: 
 

 Click on the Attachment button. 
 

 Select an image to view. 
 

To Fax Results: 
 

 Check the Fax check box on the left navigation tool bar. 
 

 Fill in the appropriate information. 
 

 Click Submit. 
 

To Print Results: 
 

 Click Print in the top navigational tool bar. 
 

 Another window will appear. 
 

 Select File and click Print. 
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To Add On Test: 
 

 Click on Add On in the top navigational tool bar. 
 

 The Add On Test window will appear. 
 

 Order Details Tab: the Diagnosis Codes and ABN signed are the only two 
features that can be modified under this tab. 
 

 Test Selection Tab: Add test(s). 
 

 To Edit a Test, click Edit after the test name. The Test Selection Data box 
will appear. Edit any of the information. Click Update. 

 
OR 

 
To Remove a Test, click on the Remove link after the test name in the 
Ordered Tests box. 
 

 Additional Comments can be added. 
 

 Click Add-On to submit the order 
 

Search by Collection Date 
 

1. From the Test Results menu, select View Results. 
 

2. Select a Start Date and an End Date. 
 

3. Select Status. 
 

4. Click Search. 
 

5. Click on a hyperlinked test accession to view the Results. 
 

NOTE: Result details can only be viewed if the test status is Final Result Available. 

 
6. The results page will appear with the options to open attachments (if applicable), print or 

fax results, and choose to add-on test(s). 
 
To View Attachment: 
 

 Click on the Attachment button. 
 

 Select an image to view. 
 

To Fax Results: 
 

 Check the Fax check box on the left navigation tool bar. 
 

 Fill in the appropriate information. 
 

 Click Submit. 
 

To Print Results: 
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 Click Print in the top navigational tool bar. 
 

 Another window will appear. 
 

 Select File and click Print. 
 
To Add On Test: 
 

 Click on Add On in the top navigational tool bar. 
 

 The Add On Test window will appear. 
 

 Order Details Tab: the Diagnosis Codes and ABN signed are the only two 
features that can be modified under this tab. 
 

 Test Selection Tab: Add test(s). 
 

 To Edit a Test, click Edit after the test name. The Test Selection Data box 
will appear. Edit any of the information. Click Update. 

 
OR 

 
To Remove a Test, click on the Remove link after the test name in the 
Ordered Tests box. 
 

 Additional Comments can be added. 
 

 Click Add-On to submit the order 
 

Download Lab Results 

1. From the Test Results menu, select Download Lab Results. 
 

2. Read the special condition for use of this feature and click on the I Agree check box and 
Next to proceed. 
 

Search by Collection Date 

 
1. Select a Result Type from the drop-down list. 
 
2. Select a Format Type from the drop-down list, to select a format for the result detail 

information to be downloaded in.  
 

3. Select a Start Date and an End Date. 
 

4. Click Search to continue with the downloading process. 
 

5. From the ‘Download file’ prompt, click Save and select the directory in which you would 
like to save the file OR click Open to view the results in a new popup window. 

 

Search by Status 
 

1. Select a Result Type from the drop-down list. 
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2. Select a Format Type from the drop-down list, to select a format for the result detail 
information to be downloaded in.  

 
3. Status should remain “Not Previously Downloaded.” 

 
4. Click Search to continue with the downloading process. 

 
5. From the ‘Download file’ prompt, click Save and select the directory in which you would 

like to save the file OR click Open to view the results in a new popup window. 
 

Batch Print Lab Results 

This option allows up to 20 results to be printed at a time. The portal will provide unprinted 
results for the past eight weeks. 
 

1. From the Test Results menu, select Batch Print Lab Results. 
 

Search by Collection Date 

 
1. Select a Result Type from the drop-down list. 
 
2. Select a Start Date and an End Date. 

 
3. Click Search. 

 

Search by Status 
 

1. Select a Result Type from the drop-down list. 
 
2. Status should remain “Not Previously Printed.” 

 
3. Click Search. 

 
 

Billing 

The Billing menu allows the user to view the billing summary and billing statements. Also 
the user can view their bills and pay them on-line. 
 

Pay Monthly Bill 

The Pay Monthly Bill page allows on-line credit card payments to be applied toward any 
outstanding balances for your account. 
 

1. From the Billing menu, select Pay Monthly Bill. 
 

2. Complete the fields with the credit card information as requested. 
 

3. Click Submit to submit the credit card information for payment. 
 

4. A confirmation page will appear giving the status of the transaction.  
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5. Print the confirmation page for your personal records by clicking on Print in the top 
navigational tool bar. 

 

View Billing Summary 

The View Billing Summary page shows a monthly summary of invoices, adjustments and 
balances.  
 

1. From the Billing menu, select View Billing Summary. 
 

2. The Monthly Summary can be printed, faxed, emailed or graphed. 
 
 To Print the Monthly Summary: 

 
 Click Print in the top navigational tool bar. 

 
 Another window will appear. 

 
 Select File and click Print. 

 
To Fax the Monthly Summary: 
 

 Click on the Distribution button. 
 

 Check the Fax check box on the left navigation tool bar. 
 

 Fill in the appropriate information. 
 

 Click Submit. 
 

To Email the Monthly Summary: 
 

 Click on the Distribution button. 
 

 Check the Email check box on the left navigation tool bar. 
 

 Enter Email Address. 
 

 Click Submit. 
 

To Graph the Monthly Summary: 
 

 Click on the Distribution button. 
 

 Click on either Bar Chart or Line Chart. 
 

 A separate window will appear viewing the graph. 
 

 The graph can be printed by clicking File and selecting Print. 
 

3. Click on the book icon to view details for a particular month’s invoice. 
 

4. The Billing Statement can be printed or faxed. 
 
 To Print Billing Statement Details: 
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 Click Print in the top navigational tool bar. 
 

 Another window will appear. 
 

 Select File and click Print. 
 

To Fax Billing Statement: 
 

 Click on the Distribution button. 
 

 Check the Fax check box on the left navigation tool bar. 
 

 Fill in the appropriate information. 
 

 Click Submit. 
 

5. Click on the PDF icon to view the printable billing statement. 
 

View Entire Fee Schedule  

The View Fee Schedule page lists the individual test prices for a specific client. Since this 
information is for internal use only, expressed written consent of Marshfield Labs must be 
obtained to distribute this information externally. 
 

1. From the Billing menu, select View Entire Fee Schedule. 
 

2. Scroll through the list to find the desired test or if you are searching for a specific test 
code, type the test code with in the Search field. 

 
3. Click the Move to Bottom, or Return to Top buttons to view lists that are longer than one 

page in length. 
 

4. While viewing the Entire Fee Schedule, the following buttons can be clicked: 
 
Move to Bottom Moves to the bottom of the list (if the list is more than one web page 

long). 
 

Move to Top Moves to the top of the list (if the list is more than one web page 
long). 

 
5. Click Print in the top navigational tool bar to print the entire fee schedule. 

 
6. The Fee Schedule can also be faxed or emailed. 

 
To Fax the Entire Fee Schedule: 
 

 Click on the Distribution button. 
 

 Check the Fax check box on the left navigation tool bar. 
 

 Fill in the appropriate information. 
 

 Click Submit. 
 

To Email the Entire Fee Schedule: 
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 Click on the Distribution button. 
 

 Check the Email check box on the left navigation tool bar. 
 

 Enter Email Address. 
 

 Click Submit. 
 

 
 
 

Management Reports 

View Courier Pickups 

The View Courier Pickups page shows the status of courier requests. 
 

1. From the Management Reports menu, select View Courier Pickups. 
 

2. Select a Start Date and an End Date. 
 

3. Click Search to retrieve the results. 
 

4. Click Print from the top navigational bar to print a copy for your personal records. 
 

5. Another window will appear. Select File and click Print. 
 

6. While viewing the Courier Status list, the following buttons can be clicked: 
 
Move to Bottom Moves to the bottom of the list (if the list is more than one web page 

long). 
 

Move to Top Moves to the top of the list (if the list is more than one web page 
long). 
 

7. The Courier Pickup Status List can also be faxed or emailed. 
 

To Fax the Courier Pickup Status List: 
 

 Click on the Distribution button. 
 

 Check the Fax check box on the left navigation tool bar. 
 

 Fill in the appropriate information. 
 

 Click Submit. 
 

To Email the Courier Pickup Status List: 
 

 Click on the Distribution button. 
 

 Check the Email check box on the left navigation tool bar. 
 

 Enter Email Address. 
 

 Click Submit. 
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View Ordered Supplies 

1. From the Management Reports menu, select View Ordered Supplies. 
 

2. Select a Start Date and an End Date. 
 
3. Select a Status using the drop-down list. 

 
4. Click Search to retrieve the results. 

 
5. Click Print from the top navigational bar to print a copy for your personal records. 

 
6. Another window will appear. Select File and click Print. 

 
7. While viewing the Ordered Supplies list, the following buttons can be clicked: 

 
Move to Bottom Moves to the bottom of the list (if the list is more than one web page 

long). 
 

Move to Top Moves to the top of the list (if the list is more than one web page 
long). 
 

8. The Ordered Supplies List can also be faxed, emailed or graphed. 
 

To Fax the Ordered Supplies List: 
 

 Click on the Distribution button. 
 

 Check the Fax check box on the left navigation tool bar. 
 

 Fill in the appropriate information. 
 

 Click Submit. 
 

To Email the Ordered Supplies List: 
 

 Click on the Distribution button. 
 

 Check the Email check box on the left navigation tool bar. 
 

 Enter Email Address. 
 

 Click Submit. 
 

To Graph the Ordered Supplies List: 
 

 Click on the Distribution button. 
 

 Click on either Bar Chart or Line Chart. 
 

 A separate window will appear viewing the graph. 
 

 The graph can be printed by clicking File and selecting Print. 
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Test Volume Report 

The Test Volume Report page creates a monthly report of client’s test volume for a 
specified year. 
 

1. From the Management Reports menu, select Test Volume Report. 
  

2. Select the year to trend from the Year drop-down list. 
 
3. Select the appropriate Sort Order for the report from the drop-down list. 

 
4. Click Next to create a Test Volume Report. 

 
5. Click Print from the top navigational bar to print a copy for your personal records. 

 
6. Another window will appear. Select File and click Print. 

 
7. While viewing the Test Volume Report, the following buttons can be clicked: 

 
Move to Bottom Moves to the bottom of the list (if the list is more than one web page 

long). 
 

Move to Top Moves to the top of the list (if the list is more than one web page 
long). 
 

9. The Test Volume Report can also be faxed, emailed or graphed. 
 

To Fax the Test Volume Report: 
 

 Click on the Distribution button. 
 

 Check the Fax check box on the left navigation tool bar. 
 

 Fill in the appropriate information. 
 

 Click Submit. 
 

To Email the Test Volume Report: 
 

 Click on the Distribution button. 
 

 Check the Email check box on the left navigation tool bar. 
 

 Enter Email Address. 
 

 Click Submit. 
 

To Graph the Test Volume Report: 
 

 Click on the Distribution button. 
 

 Click on either Bar Chart or Line Chart. 
 

 A separate window will appear viewing the graph. 
 

 The graph can be printed by clicking File and selecting Print. 
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Test Comparison Report 

The Test Comparison Report page allows a client to view a monthly volume comparison 
report of billed tests. 
 

1. From the Management Reports menu, select Test Comparison Report. 
 

2. Select the month to create the volume report for by selecting it from the Month drop-
down list. 

 
3. Select the appropriate order for the volume report from the Sort Order drop-down list. 

 
4. Click Next to create the volume report. 

 
5. Click Print from the top navigational bar to print a copy for your personal records. 

 
6. Another window will appear. Select File and click Print. 

 
7. While viewing the Test Comparison Report, the following buttons can be clicked: 

 
Move to Bottom Moves to the bottom of the list (if the list is more than one web page 

long). 
 

Move to Top Moves to the top of the list (if the list is more than one web page 
long). 
 

8. The Test Comparison Report can also be faxed, emailed or graphed. 
 

To Fax the Test Comparison Report: 
 

 Click on the Distribution button. 
 

 Check the Fax check box on the left navigation tool bar. 
 

 Fill in the appropriate information. 
 

 Click Submit. 
 

To Email the Test Comparison Report: 
 

 Click on the Distribution button. 
 

 Check the Email check box on the left navigation tool bar. 
 

 Enter Email Address. 
 

 Click Submit. 
 

To Graph the Test Comparison Report: 
 

 Click on the Distribution button. 
 

 Click on either Bar Chart or Line Chart. 
 

 A separate window will appear viewing the graph. 
 

 The graph can be printed by clicking File and selecting Print. 
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View Lab Results Trending 

Search by Patient 
 

1. From the Management Reports menu, select View Lab Results Trending. 
 

2. Select the test to trend from the Select Test drop-down list. 
 

3. Type the Patient ID into the text box given. 
 

4. Click Submit. 
 

OR 
 
If the Patient ID is unknown, click Search and follow steps 4.1 – 4.3 

 
 
 

Search Instructions: 
 

4.1 Input known information into the search criteria fields. 
 

NOTE:  When performing a search by demographic information, either a partial Last 
Name or a Telephone Number must be provided to begin the search. 

 
4.2 Click on Search to perform the patient search. 
 
4.3 The search will display a list of patients that meet the given search criteria. Click 

on the hyperlinked Patient ID to return to the previous screen (the will be ID filled 
in). 

 
 
 OR 
 
 Click on the hyperlinked Advance Search. Fill in all known information and click Search. 
 

5. Choose the Samples you wish to graph. The Select or Deselect All buttons can be 
utilized as well. 
 

6. Click Submit. 
 

7. A graph with tabled results will display in a separate window. The graph can be printed 
by clicking the File menu and selecting Print. 

 

Search by Collection Date 
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1. From the Management Reports menu, select View Lab Results Trending. 
 

2. Select the test to trend from the Select Test drop-down list. 
 

3. Select a Start Date and an End Date for the graph data. 
 

4. Check the Select Samples check box. 
 

5. Click Search. 
 

6. Choose the Samples you wish to graph. The Select or Deselect All buttons can be 
utilized as well. 

 
7. Click Submit. 

 
8. A graph with tabled results will display in a separate window. To print the graph, click the 

File menu and select Print.  
 

View Histology Charge Logs 

1. From the Management Reports menu, select View Histology Charge Logs. 
 

2. Select the Start and End date range. 
 

NOTE: The portal will only allow you to search by 30-day date ranges. 

 
3. Click Search. 

 
4. Click on the book icon to view the Histology Change Log. 

 
5. To print the report, click on File and select Print. 

 
 

Miscellaneous Options 

Change Password 

1. From the Miscellaneous Options menu, select Change Password. 
 

2. Click on the Current Password text box and type in your current password. 
 
3. Press the Tab key.  

 
OR  
 
Click on the New Password text box. 

 
4. Type your new password in the New Password text box. 

NOTE: Your New Password must be at least 7 characters long and include at least 2 numbers; 

it may not have spaces and cannot match your user name or a recently used password. 

 
5. Press the Tab key.  
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 OR  
 
 Click on the Confirm New Password text box. 
 
6. Retype your new password in the Confirm New Password text box. 
 
7. Click Submit to have password changed. 

 
8. A message will appear signifying the password has been successfully changed. 

 

NOTE: The new password will need to be used at your next Log In. 

View Access Log 

The Access Log gives a history of the activity on the user’s account.  
 

1. From the Miscellaneous Options menu, select View Access Log. 
 

2. The Access Log will display. 
 

3. To view other pages of the Access Log, click on a page number. 
 

4. To print, click Print in the top navigational tool bar. 
 

View Messages 

The View Messages page allows current messages from Marshfield Labs, coworkers, or 
yourself to be viewed or removed.  
 

1. From the Miscellaneous Options menu, select View Messages. 
 

OR 
 
Click on Messages on the top navigational tool bar. 

 
2. View a message details by clicking on the hyperlinked More.  

 
3. To remove the message, check the checkbox in front of the message and click Mark as 

Read. 
 

 

Settings 

Provider Administration 

The Provider Admin page allows new providers to be created, as well as existing providers 
to be activated or inactivated. These changes will show up when ordering tests. 
 

NOTE: Providers cannot be deleted. 

 

Create a New Provider 
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1. From the Settings menu, select Provider Administration. 

 
2. Type the provider information into the respective text boxes. 

 

NOTE: Checking the Active box means the provider will be available on drop-down lists when 

ordering tests. 

 
3. Click Submit to create the new provider. 

 
4. A message will appear signifying that the provider was successfully added. 

 
 

Manage Current Providers 
 

1. From the Settings menu, select Provider Administration. 
 

2. If checked, the provider is active, therefore aviable for use when ordering tests. 
 

3. To uncheck or check a provider, click in the check box inf front of the provider’s name. 
 

NOTE: Select all providers in your list by clicking Select All OR descelect all providers in your 

list by clicking Deselect All.. 

 
4. Type the provider information into the respective text boxes. 

 

NOTE: Checking the Active box means the provider will be available on drop-down lists when 

ordering tests. 

 
5. Click Submit to submit the changes. 

 

Test Code Administration 

The Test Code Administration page is used to manage the tests that will appear under the 
“My List” tab, which this tab will appear on the Order Tests, Change Order and Add-On 
features. Each drop-down list contains tests that have already been ordered at least once 
by your client. 
 

1. From the Settings menu, select Test Code Administration. 
 

2. Select the orderable tests from the drop-down lists. 
 

3. Click Update to immediately update the orderable tests for your client. 
 

NOTE: The selection order has not bearing. My List is currently sorted by Test Description. 

 
4. A message will appear signifying the tests have been successfully updated. 
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Request New User 

A Reference Web Portal administrator may use the Request New User feature to add a new 
user name to the selected client account.  
 

1. From the Settings menu, select Request New User. 
 

2. Type the first name of the new user into the First Name text box. 
 
3. Press the Tab key.  

 
 OR   
 
 Click on the Last Name text box. 

 
4. Type the last name of the new user into the Last Name text box. 
 
5. Click the radio button to select Administrator, or General User. 

 
6. Type in the Requestor Info (First Name, Last Name & Phone or Email). 
 
7. Enter any comments into the text box. 

 
8. Click on Submit to send the request. 

 
9. A User Request Confirmation page will display.  

 

NOTE: Marshfield Labs willl be sending you a form letter with the login and temporary 

password with two business days. 

 

Update User Security 

User Permissions allows Reference Web Portal administrators to control user access to 
options within the account information menu. 
 

 
1. From the Settings menu, select Update User Security. 

 
2. Click on the hyperlinked User Name to edit. 

 
3. Check the options to give the user access to. 
 
4. Uncheck the options to deny the user access to. 

 
5. Click Submit to make the necessary changes. 

 
6. A message will appear signifying the assigned features or clients have been updated. 

 

Select Active Client  

This feature allows users with multiple clients to select which client they want to work in. 
Only one client may be used at a time. 
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1. From the Settings menu, choose Select Active Client. 

 
2. Click on the radio button for the desired client. 

 
3. Click Submit. 

 
4. A message will appear signifying the viewable client has been updated. 

 

NOTE:  Throughout the web site, the displayed client will be shown in the top right corner of 

each page. 

 

Label Printing Settings 

This section allows users to modify their label printing settings.  
 

1. From the Settings, select Label Printer Settings. 
 

2. Select a printer from the drop down list. 
 

3. Select the number of label sets you need to copy. 
 

4. Click Apply.  Configuration Settings will set if you are successful. 
 

5. Click the button below to print a test label. 
 

Order Lab Test Settings 

The settings will take affect for all web portal users under this client. 
 

1. From the Settings, select Order Lab Test Settings. 
 

2. Click to check or uncheck the desired settings. 
 

3. Click Submit. 
 

Unviewed Results Settings 

This section will customize the behavior of the "Results" link in the top navigation bar by applying 
the selected settings.  
 
These settings will also affect actions performed on the View Results page. 
 

1. From the Settings, select Order Lab Test Settings. 
 

2. Click to check or uncheck the desired settings. 
 

3. Click Submit. 
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Packing List Settings 

This section will customize the sorting behavior of the Packing List. 
 

1. From the Settings, select Packing List Settings. 
 

2. Click to check or uncheck the desired 'sort by' settings. 
 

3. Click Submit. 
 

Test Result Settings 

This section will customize the shading behavior of the printed results. 
 

1. From the Settings, select Test Results Settings. 
 

2. Click to check or uncheck the desired 'shading' settings. 
 

3. Click Submit. 
 
This section will also customize the behavior of which results will be retrieved when batch printing 
and the behavior of the ‘sort by’ setting. 
 

1. From the Settings, select Test Results Settings. 
 

2. Click to check or uncheck the desired 'shading' settings. 
 

3. Click Submit. 
 


